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*Net Employment Outlook results range from +100% to –100%

Executive Summary Q2 Belgian Outlooks Q2 Global Outlooks About the Survey

Executive 
Summary

524 employers in Belgium (and 39,449 in 

41 countries) were asked about their 

second quarter hiring intentions and the 

reasoning behind their decisions in the 

latest edition of the ManpowerGroup 

Employment Outlook Survey.

24% Net Employment Outlook-Belgium
Calculated by subtracting employers planning reductions vs. those 

planning to hire*. Decreased by 4 points since the previous quarter 

but increased by 2 points since Q2 2024.

40% of employers who plan to hire 

reported that their company is expanding 

in size, creating more positions.

Highest Global Hiring Demand

Finance and 

Real Estate

Communication

Services
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Tough start to 2025 in the Temporary staffing industry 

Monthly business survey – February 2025

Mild improvement in business confidence in February

After holding steady last month, the business confidence indicator 

rose slightly in February.

Activity in the temporary staffing sector also folded back further 

at the beginning of 2025. Compared to the same period last 

year, the industry activity is -3.02% lower. Seasonally adjusted 

figures indicate a decrease of the TAW activity (-0.87%) 

compared to December.  

Labour Market Insights

Market update 01/2025
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*Net Employment Outlook results range from +100% to –100%
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Belgian employers both 

resilient and cautious in their 

hiring forecasts for Q2 2025 

Executive Summary

Executive Summary

Q1 Global Outlooks

Q1 Global Outlooks

About the Survey

About the SurveyExecutive Summary Q2 Belgian OutlooksExecutive Summary Q2 Global Outlooks About the Survey
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“The results of our Q2 2025 survey show that Belgian employers are demonstrating 

both resilience and caution in a complex and uncertain economic environment. hey 

are focusing on workforce stability and tight cost management. 

The job market remains subdued, and employers who are hiring are doing so

in a highly targeted manner, aligned with their expansion and transformation 

needs, as well as shifts in market demand.”

Executive Summary

Executive Summary

Q1 Global Outlooks

Q1 Global Outlooks

About the Survey

About the SurveyExecutive Summary Q2 Belgian Outlooks Q2 Global Outlooks About the Survey

Sébastien Delfosse, 

Managing Director ManpowerGroup BeLux
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Belgium Employment 

Outlook for Q2 2025

Used internationally as a bellwether of labor 

market trends, the Net Employment Outlook 

(NEO) — calculated by subtracting the 

percentage of employers who anticipate 

reductions to staffing levels from those 

who plan to hire — is now 24% in Belgium.
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Belgium Net

Employment

Outlook
24%

of employers 

anticipate an 

increase in hiring

anticipate 

a decrease

report no change

are unsure

36%

12%

50%

2%
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The Net Employment Outlook stands at +24%. This represents a decrease of 4 points compared 

to the previous quarter, but a 2-point increase compared to the second quarter of 2024.

Belgium Net Employment Outlook Over Time – Q2 2025 

+24%
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Company Expansion 
Drives Q2 Staffing 
Increases

For employers anticipating a staffing increase 

in the second quarter, company expansion 

is the top reason for recruiting.
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40%

30%

26%

24%

23%

21%

20%

16%

0%

Company growth is 

creating more jobs

Backfilling

roles

Diversity efforts are 

opening new roles

Tech advancements need 

more expertise

Specific projects need 

dedicated staff

Need the latest skills 

to stay competitive

New ventures require 

new roles

Evolving service needs are 

creating new roles

Other
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28%

26%

25%

21%

18%

16%

11%

10%

7%

Economic challenges 

impacting staffing

Adjusting jobs to 

current demand

Restructuring or 

downsizing

Automation has reduced 

some roles

Process improvements 

are consolidating roles

Market shifts lowering 

job demand

Project-based roles 

are ending

Skill changes have reduced 

certain roles

Other reasons

Economic Challenges 
Influence Workforce 
Reductions

For employers anticipating a staffing decrease 

in the second quarter, economic uncertainty 

is cited as the main challenge, followed by 

adapting to market changes.
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Economic Challenges 
Influence Workforce 
Reductions

For employers anticipating a staffing decrease 

in the second quarter, economic uncertainty 

is cited as the main challenge, followed by 

adapting to market changes.

28% 26% 25%

Economic challenges 

impacting staffing

Adjusting jobs to 

current demand

Restructuring or 

downsizing

21%

Automation has 

reduced some roles

18%

Process improvements 

are consolidating roles

16%

Market shifts lowering 

job demand

11%

Project-based roles 

are ending

10%

Skill changes have 

reduced certain roles

7%

Other reasons
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Net Employment Outlook Q2 2025 - Belgium & Regions

Employers in all 3 regions anticipate an increase in staffing levels in the second quarter of 2025 with the strongest 

Outlook in Flanders (+30%). However, since last quarter job markets have weakened in all 3 regions. 
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Belgium

+25%

+27%
+24%+22%

Brussels

2024 2025

Q2 Q1Q3 Q4 Q2

+33%

+31%
+27%

+18%

+32%

2024 2025

Q2 Q1Q3 Q4 Q2

Flanders

+31%

+26%

+30%

+28%
+19%

2024 2025

Q2 Q1Q3 Q4 Q2

+15%

+25%

+25%

+22%

Wallonia

+23%

2024 2025

Q2 Q1Q3 Q4 Q2

+28%



Used internationally as a bellwether of 

labor market trends, the Net Employment 

Outlook (NEO) — calculated by subtracting 

the percentage of employers who 

anticipate reductions to staffing levels from 

those who plan to hire — now stands at 

14% in Brussels. *Seasonally adjusted outlook
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Brussels Net

Employment

Outlook
14%

of employers 

anticipate an 

increase in hiring

anticipate a decrease

report no change

are unsure

35%

21%

43%

1%

Brussels Employment 

Outlook for Q2 2025



Used internationally as a bellwether of 

labor market trends, the Net Employment 

Outlook (NEO) — calculated by subtracting 

the percentage of employers who 

anticipate reductions to staffing levels from 

those who plan to hire — now stands at 

+28% in Flanders. 
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Flanders Net

Employment

Outlook
28%

39%

11%

48%

2%

Flanders Employment 

Outlook for Q2 2025

of employers 

anticipate an 

increase in hiring

anticipate a decrease

report no change

are unsure
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Used internationally as a bellwether of 

labor market trends, the Net Employment 

Outlook (NEO) — calculated by subtracting 

the percentage of employers who 

anticipate reductions to staffing levels from 

those who plan to hire — now stands at 

22% in Wallonia. 

15

Wallonia Net

Employment

Outlook
22%

of employers 

anticipate an 

increase in hiring

anticipate 

a decrease

report no change

are unsure

32%

10%

56%

0%

Wallonia Employment 

Outlook for Q2 2025
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41% 35%
31%

28%

22%
19%

13%
9%

Industrial

and

Materials

*Includes: Government or Public Service; Not for Profit/NGO/Charity/Religious organization; Other Industry; Other 

Transport, Logistics and Automobiles Sub-Industry; Educational Institutions; Agriculture and Fishing

Financials and

Real Estate

Communication 

Services

Transport and 

Logistics & 

Automotive

Consumer

Goods and

Services

Public Sector 

& Other*

Information

Technology

Energy &

Utilities

Health Care & 

Life Sciences

Net Employment Outlook Q2 2025 - Sectors

Belgian organizations in all 9 sectors plan to increase staffing levels in Q2 2025

16

41%
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Employers from the segment 50-249 workers anticipate the strongest hiring activity (+31%). 
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Net Employment Outlook Q2 2025 – Company size hiring

29%

Less than 10 
Employees

20%

10 - 49 
Employees

31%

50 - 249 
Employees

29%

250 - 999 
Employees

14%

1,000 - 4,999 
Employees

23%

5,000+
Employees
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Q2 Employment 
Outlooks
Global
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Global Employment 
Outlook for Q2 2025

Used internationally as a bellwether of labor 

market trends, the Net Employment Outlook – 

calculated by subtracting the percentage of 

employers who anticipate reductions to 

staffing levels from those who plan to hire – 

stands at 25%.

Global Net

Employment

Outlook
25%

of employers anticipate 

an increase in hiring

anticipate a decrease

report no change

are unsure

40%

15%

42%

3%
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Changes Over Time

Global Outlooks have remained unchanged since the previous quarter and improved when 

compared to the same time last year, increasing by 3 points.
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Hiring Expectations for April – June by Country NEO: +25%
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Seasonally Adjusted,

Net Employment

Outlooks (NEO)

25% Global
Average NEO

0% Argentina
Weakest NEO

43% India
Strongest NEO

India 43% Belgium 24% Spain 15%

U.S.A. 34% Germany 22% Japan 14%

Mexico 33% Finland 21% Puerto Rico 14%

Canada 32% France 20% Chile 13%

China 32% Panama 20% Austria 12%

Costa Rica 32% Peru 20% Israel 12%

U.K. 31% Taiwan 20% Slovakia 12%

Guatemala 29% Türkiye 20% Hong Kong 11%

The Netherlands 27% Colombia 19% Czech Republic 10%

Norway 27% Portugal 19% Hungary 8%

Singapore 27% Sweden 19% Greece 7%

Brazil 26% Italy 18% Romania 6%

Switzerland 26% Australia 17% Argentina 0%

Ireland 25% Poland 17%
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Year-Over-Year Changes by Country

Seasonally Adjusted,

Net Employment

Outlook Changes 

Since Q2 2024

+13% Israel
Most Strengthened Outlook

-5%

3% Global
Global Average Outlook
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Israel +13% Ireland +5% China +0%

Norway +11% Panama +5% Costa Rica +0%

Canada +10% Poland +5% France +0%

Taiwan +9% Colombia +4% Greece +0%

Brazil +8% Chile +3% Puerto Rico +0%

Italy +8% Global Average +3% U.S.A. +0%

Portugal +8% Guatemala +3% Hungary -1%

Türkiye +8% Japan +3% Australia -2%

U.K. +8% Singapore +3% Finland -2%

India +7% Spain +3% Slovakia -2%

Romania +7% Belgium +2% Switzerland -3%

Mexico +6% Germany +2% Hong Kong -4%

Sweden +6% Argentina +1% Austria -5%

Czech Republic +5% Peru +1% The Netherlands -5%Austria and The Netherlands
Most Weakened Outlook
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Employment Outlooks Across 
Europe and the Middle East

Hiring expectations remain the lowest in Europe and 

the Middle East (20%) and has strengthened by one 

point since Q1 2025 and four points year-over-year.  

Outlooks vary across the region with employers most 

keen to hire in the U.K.

The strongest Outlook globally for the Energy and Utilities 

industry vertical was reported by employers in 

Switzerland (59%), Healthcare and Life Sciences in 

Austria (55%), and Transport, Logistics, and Automotive 

in the Netherlands (53%).

Strongest Hiring Intentions

Weakest Hiring Intentions

U.K.

31%

The Netherlands

27%
Norway

27%

Romania

6%

Greece

7%
Hungary

8%
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About the 

Survey
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Forward-Looking Statements –
This report contains forward-looking statements, 

including statements regarding labor demand in 

certain regions, countries and industries, and 

economic uncertainty. Actual events or results 

may differ materially from those contained in the 

forward-looking statements, due to risks, uncertainties 

and assumptions. These factors include those found in 

the Company's reports filed with the U.S. Securities 

and Exchange Commission (SEC), including the 

information under the heading "Risk Factors" in its 

Annual Report on Form 10-K for the year ended 

December 31, 2024, whose information is incorporated 

herein by reference. ManpowerGroup disclaims any 

obligation to update any forward-looking or other 

statements in this release, except as required by law.

Unique – It is unparalleled in its size, scope, longevity and area of focus. The ManpowerGroup Employment Outlook 

Survey is the most extensive, forward-looking employment survey in the world, asking employers to forecast employment over 

the next quarter. In contrast, other surveys and studies focus on retrospective data to report on what occurred in the past.

Independent – The survey is conducted with a representative sample of employers from throughout the countries and 

territories in which it is conducted. The survey participants are not derived from ManpowerGroup’s customer base.

Robust – The survey is based on interviews with 39,449 public and private employers across 41 countries to measure 

anticipated employment trends each quarter. This sample allows for analysis to be performed across specific sectors and 

regions to provide more detailed information.

Focused – For more than six decades the survey has derived all of its information from a single question: “How do you 

anticipate total employment at your location to change in the three months to the end of June 2025 as compared to the 

current quarter?”

Survey Methodology – Survey responses were collected from January 2-31, 2025. Size of organization and sector 

are standardized across all countries and territories to allow international comparisons.

About the Survey

The ManpowerGroup Employment Outlook Survey is the most comprehensive, forward-looking employment 

survey of its kind, used globally as a key economic indicator. The Net Employment Outlook is derived by taking the 

percentage of employers anticipating an increase in hiring activity and subtracting from this the percentage of employers 

expecting a decrease in hiring activity. Running since 1962, various factors underpin the success of the Survey:
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Frequently Asked Questions

What is meant by Net Employment Outlook (NEO)?
The Net Employment Outlook is derived by taking the percentage of employers anticipating 

an increase in hiring activity and subtracting from this the percentage of employers that 

expect to see a decrease in employment at their location in the next quarter. A positive Net 

Employment Outlook figure means that, on balance, there are more employers who expect to 

add to their headcount in the following three months than those who intend to reduce staff.

What is Seasonal Adjustment and why is it used in the 

ManpowerGroup Employment Outlook Survey?
Seasonal adjustment is a statistical process that allows the Survey data to be presented 

without the impact of hiring fluctuations that normally occur through the course of the year, 

usually as a result of various external factors, such changes in weather, traditional production 

cycles, and public holidays. Seasonal adjustment has the effect of flattening peaks and 

smoothing troughs in the data to better illustrate underlying employment trends and provide a 

more accurate representation of the ManpowerGroup Employment Outlook Survey results.

How are companies selected for 

the survey?
Employers are selected based on the types of companies and 

organizations they represent. We want to ensure that our panel 

is representative of each participating country’s national labor 

market, so each country’s panel is built in proportion to that 

country’s overall distribution of industry sectors and 

organization sizes.

Who do you interview in each company?
The person we select to interview will be someone with a good 

overview of staffing levels and hiring intentions within their 

organization. Normally this will be the head of HR or an HR 

manager. However, in smaller organizations, that person may 

be a general manager or even the CEO.
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Workforce 

Consulting & 

Analytics

Workforce 

Management

Talent 

Resourcing

Career 

Management

Career 

Transition

Top Talent 

Attraction

Visit www.manpowergroup.com to learn more.

ManpowerGroup Solutions Across the Entire HR Life Cycle

http://www.manpowergroup.com/
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Do not Include in the Report.
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Colors in the 2025 MEOS Reports

Do not change graphic or text colors from their 
original state.

– The 2025 MEOS PowerPoint templates use additional 

colors to enhance the overall design. 

– Backgrounds, charts and text colors have been 

purposefully applied and tested for accessibility.

– Do not add new tint shades, standard colors or recent 

colors when localizing the report.



Saving the MEOS Report as a PDF

Exporting your interactive PDF:

– Delete the Appendix (slides 32-36).

– Mac: File > Save a Copy… > File Format > PDF

– PC: File > Save a Copy… > More options > PDF

– Rename and save the document as PDF.

PC

Mac



Industry Vertical & Subsector Icons
Communication

Services

Consumer Goods & 

Services

Energy 

& Utilities

Financial 

& Real Estate

Healthcare 

& Life Sciences

Industrials & 

Materials

Information 

Technology

Transport, Logistics 

& Automotive

Entertainment Food Products Oil, Gas, & 

Consumable Fuels

Banks Healthcare Providers 

& Services

Construction 

& Engineering

IT Services Automotive

Diversified 

Telecommunication 

Services

Food & Staples 

Retailing

Energy Equipment 

& Services

Insurance Pharmaceuticals Industrials 

Manufacturing

Software Road & Rail

Media & Publishing Consumer Goods & 

Services 

Manufacturing

Electric Utilities Real Estate 

Management & 

Development

Healthcare Equipment 

& Supplies

Materials 

Manufacturing

Technology Hardware, 

Storage & Peripherals

Transportation 

Infrastructure

Wireless 

Telecommunication

Hospitality Industry Diversified Financial 

Services

Healthcare Technology Construction Materials Air Freight & Logistics

Multiline Retail Consumer Finance Machinery



Accountability 

and Reliability

Active Learning 

and Curiosity

Collaboration and 

Teamwork

Creativity and 

Originality

Critical Thinking 

and Analysis

Initiative-Taking Leadership and 

Social Influence

Reasoning and 

Problem-Solving

Resilience and 

Adaptability

Teaching and 

Mentoring

Digital Native

Soft Skill Icons

Administration / 

Office Support

Engineering ESG Risk / 

Advisory / 

Governance

Front Office / 

Customer Facing

HR IT / Data Manufacturing / 

Production

Operations / 

Logistics

Other Sales / Marketing Sustainability / 

Environmental

Technical Skill Icons



Argentina Australia Austria Belgium Brazil Canada Chile

China Colombia Costa Rica
Czech 

Republic
Finland France Germany

Greece Guatemala Hong Kong Hungary India Ireland Israel

Italy Japan Mexico Norway Panama Peru Poland

Portugal Puerto Rico Romania Singapore Slovakia Spain Sweden

Switzerland Taiwan
The 

Netherlands
Turkey U.K. U.S.

Country Flag Icons Global Average
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